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Topic 1
Prepare to produce documents

Workstation safety procedure/checklist:

•• Ensure your seat is positioned in front of your computer and that you can reach 
your keyboard comfortably.

•• Position the monitor out of direct sunlight and at the correct height. 
•• Ensure the environment is dust-free as dust can affect the monitor or the 

computer’s central processing unit (CPU).
•• Ensure cables are secured so no one trips over them.
•• Use blinds and window coverings to reduce glare and heat at your workstation.
•• Ensure temperatures do not exceed 26°C and that humidity is between 40 and 60 

per cent.

Ergonomics
The aim of ergonomics is to reduce the risk of accidents, injury and illness by 
applying safe work practices. 
Ergonomics is about creating comfortable 
working conditions by adapting 
workstations, tools and equipment to 
an individual worker’s needs. It also 
improves performance and productivity 
in the workplace. Ergonomics covers all 
aspects of working, from physical stresses 
such as sitting at a workstation all day to 
environmental factors such as noise, air 
conditioning and lighting.

When your posture is poor, you may suffer 
from aches and pains. Spending a long 
time in the same position can put stress 
on your body and this can be made worse 
if you are in an uncomfortable or poorly supported position. These symptoms may be very 
slight at first, but if you continue to have poor posture your symptoms may get worse and 
become intolerable. They may result in cumulative stress given the constant strain on your 
muscles, nerves or tendons. 

When setting up your workstation, make sure your posture will not cause you pain or 
discomfort. The equipment you use needs to be adjusted to suit your body shape and size, 
and the tasks you are doing.

Ergonomic workstation design
How your workstation is designed can affect your health and wellbeing. 
Several physical problems can result from poor workstation design; for example, lower back 
strain may result from sitting in a chair that does not support your back. Some features of 
the workstation may vary depending on the type of work being performed. 
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A footrest 
may be 
necessary 

if you 
can’t place 

your feet 
comfortably on 

the floor. Footrests 
allow your feet to rest 

at the correct height and 
on a tilting angle, which prevents 

strain on the lower back.

If you 
use a 
telephone 
for long 
periods of 
time, it is a 
good idea to 
use a headset. A 
headset will keep your 
neck straight and your 
arms free. Headsets prevent you 
from bending your neck to support the 
telephone handpiece.

Angle boards allow the user to maintain 
the correct posture when reading by 
reducing the angle between the work 
surface and the user. These supports 
can be adjusted to a suitable height and 
angle, and enable comfortable reading 
with the neck correctly positioned. Try to 
keep your neck as straight as possible 

when you are reading.

Document holders are designed to 
hold papers and reference material in 
a convenient position for viewing. Place 
your document holder in the correct 
position. If it is below the screen or too 
far off to the side, each time your eyes 
look from one source to the other, your 
pupils have to adjust. Doing this for 
long periods of time can cause 
headaches and eyestrain. 
Place the document 
holder at a similar 
level, angle and 
distance as 
the screen to 
avoid having 
to shift your 
eye focus. Doc
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Setting up a home office
Communication technology and organisational policies to maintain a 
sustainable work–life balance have created opportunities for more flexible 
working arrangements. 
This means that more employees are working from home offices or in other remote 
locations. Many benefits can be derived from flexible working arrangements for employers 
and employees, but there is still a responsibility for all parties to make sure that home and 
remote offices use ergonomic practices and follow health and safety requirements.
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Designing a document refers to the way you structure and lay out the content, 
which will be determined by the information it needs to contain and the target 
audience. 
You need to consider the type of information and the clearest way to display it. For example, 
is the information best communicated in graphs or text? Would you use bullets, tables or 
columns? 

Design aspects to consider include:

•• breakout boxes
•• colour
•• columns
•• graphics, photos and drawings
•• headings
•• letter and memo conventions
•• page layout
•• white space
•• typeface.

Breakout boxes
Breakout boxes can be used to give clearly defined borders or edges to content 
on a page. 
Putting an item in a box can make it stand out. Using design elements such as boxes 
consistently on a range of documents can help the audience to quickly locate information 
they have a particular interest in. An example of this is displaying small ads in a newsletter. 
If you use the same positioning and boxed design in each edition, readers will learn to look 
for the information in that format. 

The following are two designs for a flyer. You can see how the boxes in the example on the 
right grab the reader’s attention.

2A	 Design the structure and layout of a document
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Design word-processed documents

Colour
The use of colour in documents can be valuable, both for presenting a 
consistent corporate image and for making items stand out. 
When one section of a document is in colour and the 
remainder is in black and white, the reader’s eye is 
automatically drawn to the coloured section.

You may also need to consider the colour of the paper 
you will be printing your document on, as some fonts 
and graphics may not be easy to see on coloured 
paper; for example, black print can sometimes be 
hard to read on dark red or navy blue paper.

Look at newspapers and magazines to find examples 
of the effective use of colour. Advertisers often pay 
extra for coloured advertisements to make them 
stand out.
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Columns
Columns are a popular design element for forms and newsletters. 
In newsletters, columns can be used to create interest and to separate articles. Altering the 
number of columns can give you more options to insert graphics and tables, allowing you to 
fully utilise the space.

Look at the first version of the Capricorn State School newsletter. The top article appears 
to have too much white space or gaps and the information in the second two articles is 
mixed with the tables. This is not a well-designed document. In the second version of the 
document, you can see how the use of two columns in the top half of the page fits in the 
three small articles and makes them easy to read. 

Formatting tables
When designing forms, tables are often used to insert rows and columns, which 
allow for the effective collection of data in the available space. 
If any of your tables extend over a single page, you can use the Heading Rows Repeat 
command to automatically show the table headings on each page.

To do this, create a table and select the row/s that you want repeated at the top of each page. 
You must include the first row in the table, but can choose additional rows if desired.

Click the Layout tab, and then select Repeat Header Rows. The rows you selected will now 
be repeated on each page of the table.

Note: This command only works for automatic page breaks. It will not work if you insert 
manual page breaks in your table.
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Paragraph 
and line 
spacing

Another technique you can use to achieve additional emphasis on 
headings is to adjust the spacing before and after headings and lines of 
text. To do this, select the paragraph icon, then make adjustments where 
it says ‘Spacing’.

Practice task 5

Your company is hosting its annual end-of-year staff party and you have been asked to 
design a flyer to advertise the function to staff. Information to be included in the flyer is as 
follows:

Company name: Pack and Go Express Couriers
Date: 16 December 2018
Time: 5.00 pm until late
Venue: Rush Restaurant and Club
Address: 41 Villa Street, Fremantle
RSVP: 10 December 2018
Dress: Themed party: 80s revival – prize for best dressed
Cost: No charge
Program:
5.00 pm Pre-dinner drinks
6.30 pm Buffet dinner
8.00 pm Awards and speeches
9.00 pm Entertainment – live band

Create the document in Word. Ensure you apply what you have learnt in this topic about 
document design and layout. Save and print your finished document.
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To insert an object from another program, select the Insert tab, click Object, then choose 
Object from the drop-down menu. Select the Create from File tab, then click Browse. 
Locate the drive and folder containing the data you wish to import, and double-click on the 
file name. Click OK. 

The file will be placed into your document. Sometimes the object that is inserted will be too 
big, so you may need to resize it and then edit it to ensure the correct data is displayed. 

Edit imported data
To edit the object you have imported, double-click on it and you will be in 
editing mode. 
The tools you have available to edit an object will depend on the program that the object was 
created in. You will generally have a lot of the same functions you had when you created the 
object in the original program.

Often Excel worksheets will contain a number of rows and columns of data. You may not 
want all the data to be shown in your Word document, so you may need to adjust the range 
of cells that are on display.

Double-click on the Excel object to enter editing mode. You will be presented with a ‘mini’ 
version of Excel complete with the various worksheets and scroll bars for moving through 
the data. 
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10.	 Click Next: Preview your letters. Use the forward and backward arrows in the panel to 
preview each letter. 

11.	 Click Next: Complete the merge. Click Edit individual letters. Select All and click OK.

12.	 Select the File tab and choose Save As. Save the file to an appropriate place on your 
computer or network server.

Edit documents
Once you have drafted a document, the next step is to review and edit it to 
ensure it meets organisational and task requirements. 
You need to check the style and layout of the document and you must also check the 
spelling, grammar and punctuation.

Make sure you allow time for editing and proofreading documents before they are printed, 
published or distributed to colleagues. You may need to complete a final check of the style 
and layout specifications and look out for spelling and grammatical errors.

Many organisations have a checklist to help people systematically go through the points 
that need to be considered before a document is finalised. Your organisation may have some 
special requirements that need to be checked as part of the editing process, so make sure 
you are familiar with these. 

Below are some aspects to keep in mind when editing and proofreading documents.

Document type

Ensure you have selected the correct type of document. For example, when asked to 
collect some information, do the results need to be presented in a report or can they go 
into a memo?

Audience, purpose and contents

Is the document you have produced suitable for the audience and purpose? Does it 
need to be formal or informal? Is the language appropriate? Is there too much jargon? Is 
all the required information included? Is it presented in an easy-to-understand format?

Spelling, grammar and punctuation

Be aware that an electronic spelling and grammar checker will not always pick up 
words that are used inappropriately (such as using ‘there’ instead of ‘their’), so it is 
best to also proofread your document. Words may also be spelt in different ways; for 
example, American and Australian spelling for words such as organize/organise. Check 
the in-house style manual. You will need to use your discretion to decide whether the 
suggested option actually is the best (or even correct!) one.

Style

Ensure you have used the correct template, if one is available. Have you followed the 
guidelines in the organisation’s in-house style manual, including use of logos and fonts? 
Is the style consistent? Make sure headers and footers are correct and spacing is 
consistent throughout. Check the in-house style manual. 
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Learning checkpoint 3 
Produce digital text documents

Part A
You work for Plant Paradise. The business does not currently have any templates and you 
have been given the following tasks to complete.

1.	 Design a template for a promotional flyer with the following details.
Plant Paradise
124 Sunhill Street, BUDERIM QLD 4556
Ph: 07 5423 9912
Email: inquiries@plantparadise.com.au
Website: www.plantparadise.com.au

2.	 Use a suitable image as part of the header.

3.	 Ensure the paper size is A4 and set the top and bottom margins to 1cm and the left and 
right margins to 2cm.

4.	 Save the template as ‘Plant-Paradise-flyer’.

Part B
Read the case study, then complete the task that follows.

Case study
You work for Johnson’s Motors, a car dealership that sells and services Toyota and Suzuki vehicles. A 
new computer system has just been installed and you have been asked to create a folder structure 
that will meet their needs. It is important that they keep the information for Toyotas and Suzukis 
separate. They need to store the following information for each make of vehicle:

•• Sales
•• Servicing
•• Marketing

You also need to store electronic files on employees, advertised positions and accounting data.

Design a folder structure to suit Johnson’s Motors. Make sure you choose names that are 
consistent, simple and meaningful.


